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Présentation d'Excel 
 
Microsoft Excel est le tableur de la suite bureautique Microsoft Office. Pour le lancer il 
suffit de cliquer sur l'icone appropriée de votre menu Démarrer (sous Windows) ou 
bien de cliquer sur un fichier Excel (dont l'extension est .xls). 
Un document Excel est appelé classeur, il contient une ou plusieurs feuilles de calcul, 
présentes sous formes d'onglets en bas de page. 
 

Présentation de l'interface 
 
L'interface de Microsoft Excel est présentée ci‐dessous : 

 

Elle est composée de divers éléments : 

1. Une barre de titre indiquant le nom de l'application ainsi que le nom du classeur ouvert 

2. Une barre de menu permettant d'accéder aux différentes fonctions du tableur 

3. Une barre d'outils proposant sous forme d'icônes des accès direct aux principales fonction‐
nalités. Il est intéressant de noter que cette barre peut‐être personnalisée afin de vous permettre 
de mettre des raccourcis vers les fonctionnalités que vous utilisez le plus 
4. Une barre de formules donnant l'adresse de la cellule sélectionné et indiquant son contenu. 
La barre de formule vous permet ainsi de saisir les données à insérer dans les cellules 
5. La feuille de calcul est l'élément clé du tableur, c'est le tableau contenant toutes les cellules. 
En bas de la feuille de calcul affichée se trouvent des onglets permettant de passer d'une feuille 
de calcul à une autre. 
6. La barre d'état donne des informations sur les actions à entreprendre. Par défaut le mes‐
sage prêt est affiché dans la barre d'état 
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Les opérateurs texte 
 
L'opérateur de concaténation 
 
Les tableurs offrent généralement un opérateur, appelé opérateur de concaténation, per‐
mettant de joindre deux valeurs textuelles. L'opérateur de concaténation, noté &, s'utilise 
de la manière suivante : 
 

 
 

Dans l'exemple ci‐dessus, la valeur de la cellule B15 ("Total TTC") est calculé automatique‐
ment en concaténant la valeur de la cellule B13 (dont la référence absolue est no‐
tée $B$13), une chaîne composée d'un espace "  ", et la valeur de la cellule E5 (dont la 
référence absolue est notée $E$5), grâce à la formule suivante : 
 
=ΧBΧϣϥ & " " & ΧEΧϧ 
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Les expressions conditionnelles 
 
On appelle structure conditionnelle les instructions qui permettent de tester si une condi‐
tion est vraie ou non. Les structures conditionnelles peuvent être associées entre elles. 
Pour pouvoir mener à bien ces tests à l'aide de fonctions logiques, les tableurs proposent 
des opérateurs permettant de comparer des valeurs. On appelle ces opérateurs 
des opérateurs relationnels. 
 

Les opérateurs relationnels 
 
Les opérateurs relationnels sont les suivants : 
 
 
 

 
 
 
 
 
 
 

Opérateur Dénomination Description 

= opérateur d'égalité Compare deux valeurs et vérifie leur égalité 

< opérateur d'infério‐
rité stricte 

Vérifie qu'une variable est strictement inférieure à 
une valeur 

<= opérateur d'infério‐
rité 

Vérifie qu'une variable est inférieure ou égale à une 
valeur 

> opérateur de supé‐
riorité stricte 

Vérifie qu'une variable est strictement supérieure à 
une valeur 

>= opérateur de supé‐
riorité 

Vérifie qu'une variable est supérieure ou égale à 
une valeur 

<> opérateur de diffé‐
rence Vérifie qu'une variable est différente d'une valeur 
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Déplacement dans un classeur 
 
Pour pouvoir travailler efficacement avec un tableur, vous devez être en me-
sure d’y naviguer à votre guise. Outre les icônes et commandes principales des 
menus, un certain nombre de raccourcis clavier facilitent la navigation. 
 

Navigation entre feuilles de calcul d'un classeur 
 
Avec la plupart des tableurs, les feuilles de calcul du classeur sont affichées, 
comme avec Excel, sous la forme d’onglets en bas à gauche de la fenêtre. Ex-
cel nomme ces feuilles par défaut Feuil1, Feuil2… tandis que Calc propose les 
noms Feuille1, Feuille2… L’onglet de la fenêtre active (celle qui est affichée à 
l’écran) figure en surbrillance. Vous pouvez modifier la fenêtre active en cli-
quant sur l’onglet qui porte le nom de la fenêtre à 
activer.  
 
Cette méthode n’est toutefois pas très pratique si 
votre classeur contient un très grand nombre 
d’onglets. Excel propose une alternative très effi-
cace : 
 
Effectuez un clic droit sur les flèches situées en bas à 
gauche : 
 
 
 
Une liste s’affiche. Si la feuille de calcul recherchée y 
est mentionnée, cliquez dessus pour l’activer. Sinon, 
cliquez dans cette liste, sur Plus de feuilles… : 
 
• Une boîte de dialogue s’ouvre avec la liste des 
onglets : 

 
 
 
 
 
 
 
 
Plusieurs possibilités s’ouvrent à vous 
pour sélectionner celui que vous cher-
chez : 
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• Faites défiler jusqu’à le trouver dans la liste, sélectionnez‐le en cliquant dessus puis 
sur OK ou double‐cliquez directement dessus. 

• Saisissez les premières lettres de son nom (voire son nom en entier), sélectionnez‐
le en cliquant dessus puis sur OK ou double‐cliquez directement dessus. 

• Avec Calc, choisissez Édition > Feuille > Sélectionner, puis choisissez la feuille adé‐
quate dans la fenêtre qui s’affiche. 
 
La feuille de calcul sélectionnée est alors activée et s’affiche à l’écran. 
 

Navigation dans une feuille de calcul 
 
Elle s’effectue tout simplement à l’aide des touches flèches et des barres de dé-
filement situées en bas et à droite.  
Sous Windows, plusieurs raccourcis clavier permettent de faciliter la navigation, 
comme le montre le tableau suivant.  
 

Raccourci clavier Effet 
Tabulation Déplacement d’une cellule vers la droite 

Maj+Tabulation Déplacement d’une cellule vers la gauche 

Entrée Déplacement d’une cellule vers le bas 

Ctrl+Origine Retour à la cellule A1 (l’origine) depuis n’importe quel 
point de la feuille de calcul 

Ctrl+Fin Déplacement vers la dernière cellule possédant un quel‐
conque contenu (si le classeur est vide, vous revenez à la 
cellule A1) 

Origine Déplacement vers le début de la ligne courante 

Page suivante Déplacement d’un écran vers le bas 

Page précédente Déplacement d’un écran vers le haut 

Alt+Page suivante Déplacement d’un écran vers la droite 

Alt+Page précédente Déplacement d’un écran vers la gauche 

Ctrl+Page suivante Déplacement vers la feuille de calcul suivante du classeur 

Ctrl+Page précédente Déplacement vers la feuille de calcul précédente du clas‐
seur 

 Ϧϧ 

 

De l'utilisation des parenthèses 
 
Les opérateurs arithmétiques possèdent un ordre de priorité. Ainsi, si vous souhaitez mo‐
difier la priorité par défaut des opérateurs, il est possible d'utiliser des parenthèses. Voici 
une table présentant la priorité des opérateurs : 
  
        
      
     
         
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
     

++++++ ()  

+++++ %  

++++ ^  

+++ ‐  

++ * / 

+  + ‐ 

Priorité des opérateurs 
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La notion d'expression 
Les expressions permettent au tableur d'effectuer des calculs simples mettant en jeu des 
valeurs provenant de plusieurs cellules. On distingue généralement plusieurs types d'ex‐
pressions : 
 

Les expressions arithmétiques 
 
Les expressions arithmétiques sont des expressions simples construites avec des opéra‐
teurs arithmétiques et des constantes ou des références à des cellules. On ap‐
pelle opérandes les valeurs sur lesquelles l'opérateur agit. On distingue deux types d'opé‐
rateurs arithmétiques : 
 
•Les opérateurs unaires agissant sur un seul élément; n'admettant donc qu'une seule 
opérande, située à droite de l'opérateur. Par exemple : 
=-A6 
 
•Les opérateurs binaires agissant sur deux éléments (admettant deux opérandes, situées 
de part et d'autre de l'opérateur). Par exemple : 
=B4 + A6 
 
Les opérateurs arithmétiques sont les suivants :  
    

 

Opérateur Dénomination Type Description 

+ 
Opérateur d'addition Binaire Ajoute deux valeurs 

‐ 
opérateur de sous‐
traction 

Binaire Soustrait deux valeurs 

* 
opérateur de multi‐
plication 

Binaire Multiplie deux valeurs 

/ 
opérateur de divi‐
sion 

Binaire Divise deux valeurs 

^ 
opérateur de puis‐
sance 

Binaire Elève l'opérande de gauche à la puissance 
précisée par l'opérande de droite 

% 
opérateur modulo Binaire Donne le reste de la division entière entre 2 

nombres 
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Contenu d'une feuille de calcul  

Une cellule est l’élément unitaire fondamental d’une feuille de calcul. Vide par 
défaut, elle peut le rester ou bien contenir une valeur, ce qui est généralement 
plus utile. La valeur d’une cellule possède deux caractéristiques essentielles : 
• Son type de donnée. Il est principalement distingué quatre types de valeurs : 
• des valeurs littérales numériques, par exemple 3,1415927, 58 %, ou 1984 ; 
• des valeurs littérales alphanumériques, par exemple Tableau2, Titre ou Nom ; 
• des formules, c’est‐à‐dire une expression représentant un calcul en fonction de 
données. Les formules sont évaluées par le tableur. Le texte, les chiffres et les formules 
que vous tapez dans une cellule sont immédiatement affichés dans la barre de for‐
mule ; 
• éventuellement des objets, qui peuvent être de types très divers (images, sons, 
vidéos, etc.) selon les capacités du tableur concerné. 
• Son style, qui se décompose en style de valeur (dépendant du type de données 
considérées) et style de cellule (indépendant du contenu). 
 
Une cellule Excel peut renfermer jusqu’à 65 000 caractères. La quantité de texte 
affichable dans une cellule dépend de la largeur de la colonne qui contient la 
cellule, de la mise en forme de la cellule et de son contenu.  
Lorsqu’une feuille de calcul est active, une cellule au moins est active et porte 
donc le nom de cellule active. Elle est généralement représentée avec une bor-
dure plus épaisse, le plus souvent noire. Le contenu d’une cellule active est affi-
ché dans la barre de formule et son adresse (ou son nom si vous lui en avez 
attribué un) dans la zone d’adresse située en haut à gauche.  
 
Ne confondez pas le style de la valeur, lié au type de données qui y réside, avec le style 
de la cellule, c’est‐à‐dire les enrichissements dont elle a pu être dotée. Nous verrons 
comment modifier le style d’une valeur et le style d’une cellule dans la suite de ce cha‐
pitre.  
 

Mise en forme de données 
 

Styles de données 
 
Que la cellule contienne une valeur littérale saisie par vous-même ou le résultat 
d’une formule, vous affectez un style aux données de cette cellule en définissant 
ce que l’on appelle le format de la cellule : cela conditionne la manière dont la va-
leur va être représentée par le tableur. Pour définir le format d’une cellule, il suffit 
de sélectionner la cellule en cliquant dessus, puis de choisir dans le menu Format 
> Cellule et de sélectionner l’onglet Nombre (ou Nombres avec Calc). Le tableur 
va ainsi proposer une série de formats classés par catégorie : 
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Excel et Calc proposent tous deux des options très similaires. Les principaux for-
mats classiques sont Nombre, Pourcentage, Monétaire, Date, Heure, Scientifique, 
Fraction, et Texte, mais votre tableur peut en proposer d’autres.  
Chaque format de cellule (ou style de données) propose souvent des sous-
formats, possédant également des caractéristiques propres.  
Vous n’êtes pas limité aux formats prédéfinis : la plupart des tableurs permettent 
de créer des formats personnalisés.  
Il est possible d’affecter simultanément un même style à plusieurs cellules, conti-
guës ou non. Pour ce faire, il suffit de sélectionner la zone concernée, puis d’appli-
quer le format retenu. La sélection de plages de cellules fait l’objet du prochain 
chapitre.  
 
Exactement comme le résultat affiché d’une formule n’est pas la formule elle‐même, l’ap‐
plication d’un format de données peut procurer (et procure généralement) un affichage 
différent du contenu réel de la cellule. Une fois encore, seule la barre de formule affiche 
exactement le contenu d’une cellule.  
Saisir par exemple littéralement « 243,00 € » dans une cellule, car la colonne présente cet 
aspect, peut aboutir à la génération d’une erreur si la colonne ne contient que des 
nombres et est mise au format Monétaire avec symbole monétaire. S’il est calculé une 
somme sur cette colonne, le résultat sera faux car cette saisie sera interprétée comme 
texte et non prise en compte dans la somme. C’est une erreur aussi fréquente que diffi‐
cile à repérer, rien ne semblant anormal au tableur : une saisie correcte serait « 243 », « 
243,0 » ou « 243,003 ». 
 

Modification de la hauteur des lignes et de la largeur 
des colonnes 
 
Avec Excel, les cellules d’une nouvelle feuille de calcul utilisent par défaut le for-
mat Standard. Excel ajuste automatiquement la largeur de colonne afin d’afficher 
les nombres saisis. À l’exception des formats de dates et de certains formats per-
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ASTUCE 
 
Pour éviter de remplir les cellules avec des valeurs différentes, maintenez la 
touche CTRL enfoncée.  
 
Vous trouverez les séries prédéfinies de Calc sous Outils > Options > OpenOf-
fice.org Calc > Listes de tri et celles d’Excel dans Outils > Options, dans l’onglet 
Listes pers. Il est (heureusement) possible de créer vos propres listes personnali-
sées.  
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Listes de données 
 
Il est fréquent de devoir saisir une liste de termes répétitifs, qu’il s’agisse d’en-
têtes de ligne ou de colonne ou de données. Les tableurs proposent généralement 
des listes déjà prédéfinies. Ces listes permettent de saisir une information dans 
une cellule, puis de la faire glisser de manière à créer une liste consécutive d’infor-
mations.  
 
Par exemple, saisissez le texte « Janv » ou « Janvier » dans une cellule vide. Sé-
lectionnez la cellule, puis cliquez sur le coin inférieur droit du bord de celle-ci. En-
suite, faites glisser la cellule sur plusieurs cellules vers la droite ou vers le bas. 
Lorsque vous relâchez le bouton, les cellules mises en évidence affichent les 
noms des mois. Cela fonctionne de la même façon avec une suite numérique. 
 

 

 ϩ 

 

sonnalisés, si vous appliquez un format numérique donné à une cellule, tel Moné-
taire avec deux décimales, Excel élargira la cellule afin de s’adapter au format 
sélectionné en arrondissant si nécessaire les décimales, ce que ne fait pas Calc.  
Si la largeur de la cellule ne permet pas d’afficher un nombre selon le format rete-
nu, elle affiche des signes dièse (###). Pour voir la valeur contenue dans la cel-
lule, vous devez élargir la colonne. 
 

Élargissement d’une colonne 
 
Plusieurs méthodes s’offrent à vous : 
• Vous pouvez placer le curseur de la souris dans les en‐têtes de colonne, sur la ligne 
qui sépare la colonne concernée de la suivante. Le pointeur se transforme d’une flèche 
(sauf si vous avez modifié l’apparence du curseur) en une ligne verticale traversée d’une 
flèche bicéphale horizontale. Cliquez et glissez‐déposez la ligne de séparation vers la 
droite, puis relâchez le bouton de la souris. Si la valeur n’apparaît pas, recommencez. Re‐
marquez que vous pouvez faire de même vers la gauche pour réduire la largeur d’une 
colonne. 
• Cliquez dans l’en‐tête de colonne sur sa lettre pour sélectionner la colonne, puis choi‐
sissez dans le menu Format > Colonne. Vous pouvez alors choisir Largeur et entrer une 
largeur explicite, ou choisir Ajustement automatique (avec Excel) ou Largeur optimale 
(avec Calc) de façon à ce que la largeur de la colonne s’adapte à la meilleure valeur pos‐
sible. 
 
Bien sûr, vous pouvez employer cette dernière solution sur une sélection multiple 
de colonnes pour les élargir simultanément. 
 

Augmentation de la hauteur des lignes 
 
C’est plus rarement nécessaire, puisque nécessité généralement par du texte qui 
doit pouvoir s’étendre sur plusieurs lignes d’une même ligne. La démarche est 
strictement analogue : 
• Placez le curseur de la souris dans la colonne des numéros de ligne, sur la ligne qui 
sépare la ligne concernée de la suivante. Le pointeur se transforme d’une flèche (sauf si 
vous avez modifié l’apparence du curseur) en un trait horizontal barré d’une flèche bicé‐
phale verticale. Cliquez et glissez‐déposez la ligne de séparation vers le bas, puis relâchez 
le bouton de la souris. Si la valeur n’apparaît pas, recommencez. Remarquez que vous 
pouvez faire de même vers le haut pour réduire si nécessaire la hauteur d’une ligne. 

• Cliquez dans l’en‐tête de ligne sur son numéro pour sélectionner la ligne, puis choisis‐
sez dans le menu Format > Colonne. Vous pouvez alors choisir Hauteur et entrer une va‐
leur explicite, ou choisir Ajustement automatique (avec Excel) ou Hauteur optimale (avec 
Calc) de façon à ce que la hauteur de la ligne s’adapte à la meilleure valeur possible. 
 
Vous pouvez également employer cette dernière solution sur une sélection mul-
tiple de lignes pour ajuster simultanément leur hauteur. 
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Commentaire 
 
Excel permet d’ajouter un commentaire (parfois appelé annotation) à une cellule 
afin de fournir des informations additionnelles que l’on ne souhaite pas (ou que 
l’on ne peut pas) voir figurer dans la feuille de calcul.  
Pour ajouter un commentaire à une cellule, sélectionnez la cellule ou la plage de 
cellules à nommer puis choisissez Insertion > Commentaire. Vous pouvez égale-
ment effectuer sur la cellule un clic avec le bouton droit de la souris et choisir Insé-
rer un commentaire. 
 

 
 
Après avoir inséré un commentaire, un petit triangle rouge en haut à droite (voir la 
cellule D5 de la figure précédente) indique que la cellule possède un commentaire 
et invite l’utilisateur à survoler la cellule avec sa souris pour en voir le contenu.  
Vous pouvez personnaliser le format de ce commentaire, bien que la démarche ne 
soit que chichement expliquée dans la documentation : 
• Placez‐vous sur la cellule commentée et effectuez un clic droit sur Modifier le com‐
mentaire. 
• Placez le curseur dans l’angle en bas à droite du commentaire, jusqu’à faire appa‐
raître la petite double flèche inclinée, puis cliquez droit. 
• Sélectionnez Format du commentaire. 
 
Vous avez maintenant accès à une palette de réglages beaucoup plus riche, per-
mettant notamment de choisir la couleur de fond, le format et la couleur du texte, 
les traits, le dimensionnement automatique, etc. Il est même possible d’y insérer 
une photo, ce qui peut se révéler très intéressant pour une liste nominative, une 
énumération de lieux, un inventaire d’objets ou de pièces détachées…  
 
 

 Ϧϣ 

 

ASTUCE 
 
Il arrive à tout le monde d’oublier de finir de saisir une entrée dans une cellule 
avant d’essayer d’accéder à une commande ou à un autre objet dans un classeur. 
Dans la plupart des cas, Excel terminera la saisie pour vous. Cependant, parfois, 
Excel fera entendre un bip.  
Si vous ne pouvez accéder à un élément qui normalement devrait être disponible, 
vérifiez deux choses : 
 
• Voyez‐vous les boutons Annuler (le X rouge) et Entrer (la coche verte) dans la barre 
de formule ? 
• Avec Excel, le mot Modifier apparaît‐il dans la barre d’état en bas de la fenêtre ? 
 
Si la réponse est oui, vous avez oublié de finir la saisie d’une entrée. Pour remé-
dier à cela, appuyez sur ENTREE, TAB ou une des flèches de direction.  
 

 
 

Validez. Cette cellule n’acceptera désormais que des nombres entiers compris entre 1 et 
10, et rejettera toute saisie non conforme en affichant un message. 

 

 



 ϦϢ 

 

Si la formule saisie après le signe égal (=) ne possède pas une syntaxe correcte, le tableur 
affichera un message d’erreur précédé du caractère #. Ainsi, en cas de référence à une 
cellule invalide, le tableur affichera la valeur #REF!.  
Prenez garde à toujours bien distinguer le résultat affiché par une cellule (tel que calculé 
par le tableur) et la formule qu’elle contient réellement. Si la cellule ne contenait que le 
résultat, un tableur ne présenterait que peu d’intérêt. 
 
EXEMPLE  
 
Saisissez dans la cellule A1 (celle en haut à gauche) =2+2, puis appuyez sur 
ENTREE. Vous voyez apparaître dans la cellule le chiffre 4, et non la formule que 
vous avez entrée. Cliquez à nouveau (une seule fois) sur la cellule A1. Celle-ci 
affiche bien toujours 4, mais vous voyez dans la barre de formule le contenu réel 
de la cellule, soit « =2+2 ».  
 
Si vous aviez par inadvertance saisi « 2+2 » au lieu de « =2+2 », la présence du signe + 
aurait fait que l’expression ne serait pas reconnue comme une formule mais comme une 
donnée alphanumérique : la cellule contiendrait alors et afficherait la chaîne « 2+2 ». Ne 
souriez pas, c’est une erreur bien plus fréquente qu’il n’y paraît !  
Pour rectifier, ajoutez simplement un signe = au début de la chaîne dans la barre de for‐
mule, et tout rentrera dans l’ordre. 
 
Une formule peut contenir des références à d’autres cellules, des expressions, 
c’est-à-dire des opérateurs permettant d’effectuer des opérations simples sur les 
valeurs de cellules, ainsi que des fonctions.  
 
Formules, opérateurs et fonctions seront étudiés plus en détail au chapitre 3.  
Après avoir entré des données dans une cellule, un appui sur la touche ENTREE 
valide la saisie et rend active la cellule située en dessous. Appuyez plutôt sur la 
touche TAB pour valider l’entrée et passer à la cellule de droite. Vous pouvez aus-
si recourir aux touches fléchées pour valider et passer à la case suivante dans la 
direction de la flèche. Tant que la saisie n’est pas achevée (le curseur clignote 
dans la cellule ou dans la barre de formule), la plupart des commandes du tableur 
ne peuvent être exécutées.  
 
Pour annuler une saisie en cours, appuyez sur ECHAP ou cliquez sur le bouton 
Annuler (le X rouge dans la barre de formule) afin d’annuler l’entrée et de recom-
mencer.  
 
Si vous avez déjà appuyé sur ENTREE après avoir terminé une saisie vous pou-
vez resélectionner la cellule et appuyer sur SUPPR pour effacer son contenu. 
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Sélection de cellules 

 
Un tableur est un formidable outil de manipulation de données. Qu’il s’agisse tou-
tefois de référencer des cellules isolées ou des plages de cellules, que ce soit 
pour les besoins d’une formule, pour leur attribuer un format de cellule ou un style, 
il est nécessaire de maîtriser les outils et techniques permettant de sélectionner 
rapidement toutes les cellules nécessaires. 
 

SELECTION DE CELLULES CONTIGUËS 
 
Sélection de lignes  
Il est possible de sélectionner une ligne entière en cliquant directement sur l’en-
tête de ligne, c’est-à-dire sur son numéro, dans la barre de gauche : 
 

 
 
Il est également possible de sélectionner une ligne avec le clavier en se position-
nant sur une cellule située sur la ligne à sélectionner puis en appuyant simultané-
ment sur MAJ+BARRE D’ESPACE. 
 

Sélection de colonnes 
 
De la même façon que pour sélectionner des lignes, il est possible de sélectionner 
une colonne entière en cliquant directement sur l’en-tête de colonne, c’est-à-dire 
sur sa lettre dans la barre d’en-tête : 
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Il est également possible de sélectionner une colonne avec le clavier en se posi-
tionnant sur une cellule située sur la colonne à sélectionner puis en appuyant si-
multanément sur CTRL+BARRE D’ESPACE.  
 
==Sélection d’une plage de cellules==  
 
Pour sélectionner une plage de cellules (appelée aussi bloc de cellules), il suffit de 
cliquer sur une cellule (cellule de début) et de déplacer la souris tout en mainte-
nant le bouton gauche appuyé afin de faire un rectangle de sélection jusqu’à la 
cellule de fin : 
 

 
 
Remarquez que la zone d’adresse (en haut à gauche) indique le nombre de lignes 
et de colonnes présentes dans la sélection.  
 

À SAVOIR 
 
La cellule de début s’affiche d’une couleur différente (en blanc). Elle appartient 
pourtant à la sélection au même titre que les autres cellules du cadre !  
Il est également possible de sélectionner une plage de cellules en cliquant sur la 
cellule de début, puis en cliquant sur la cellule de fin en maintenant enfoncée la 
touche MAJ.  
Exactement comme il est possible de sélectionner plusieurs cellules contiguës, 
vous pouvez sélectionner plusieurs lignes contiguës. Pour ce faire il suffit de sé-
lectionner la ligne de début, puis de cliquer sur la ligne de fin en maintenant enfon-
cée la touche MAJ : 
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• Dans l’onglet Message de saisie (ou Aide à la saisie), renseignez comme suit les 
champs : 
 
· Titre : Nombre entier 1-10  
· Message de saisie (ou Aide à la saisie) : Saisir un nombre entier compris entre 1 
et 10 – ce message s’affichera dès que vous sélectionnez une cellule de la plage. 
 

 
 

• Dans l’onglet Alerte d’erreur (ou Message d’erreur), renseignez comme suit les 
champs : 
 
· Style (ou Action) : Arrêt (ou Arrêter)  
· Titre : Saisie incorrecte !  
· Message d’erreur : Vous devez saisir un nombre entier compris entre 1 et 10 
 
 
Les formules 
 
Une formule est une expression, qui, lorsqu’elle est interprétée par le tableur, ef-
fectue un calcul soit interne, soit plus fréquemment en employant des valeurs pré-
sentes dans d’autres cellules.  
 
Pour saisir une formule dans une cellule, il suffit de sélectionner la cellule puis de 
commencer la saisie en entrant le signe égal (=). Vous saisissez ensuite l’expres-
sion qui doit être évaluée. Celle-ci saisie, appuyez sur ENTREE : le tableur inter-
prète la formule et affiche le résultat correspondant.  
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ASTUCE 
 
Avec Excel et Calc, vous pouvez vérifier l’orthographe de toutes les entrées texte, 
y compris le nom des feuilles, les en-têtes de liste, etc., en choisissant Outils > 
Orthographe ou en cliquant sur le bouton Orthographe de la barre d’outils. 
 
ASTUCE : AJOUTER UNE DATE FIXE DANS UNE CELLULE (EXCEL) 
 
Si vous souhaitez insérer la date du jour en cours dans une cellule, au format jj/
mm/aaaa, et que celle-ci reste fixe sans être remise à jour à chaque ouverture du 
fichier (par exemple pour indiquer la date de création du fichier), placez-vous sur 
la cellule choisie et appuyez sur CTRL+ ; (point-virgule).  
De même, pour insérer l’heure au format hh:mm, appuyez sur CTRL+ : (deux-
points). 
 
Validation de la saisie 
 
La commande de menu Données > Validation (Excel) ou Données > Validité 
(Calc) est peu connue et rarement employée. Elle permet pourtant de placer des 
contraintes (éventuellement allant jusqu’à l’interdiction de toute saisie) sur des 
cellules « stratégiques » de votre feuille, en affichant le cas échéant un message 
d’alerte.  
Ces messages d’alerte peuvent être fondés sur des conditions ou le résultat de 
formules.  
Par exemple, pour limiter la saisie dans une cellule (ou un groupe de cellules) à un 
nombre entier compris entre 2 valeurs (par exemple 1 et 10), procédez comme 
suit : 
 
• Choisissez Données > Validation (ou Données > Validité). 
• Dans l’onglet Options, renseignez comme suit les champs : 
 
· Autoriser : Nombre entier  
· Compris entre : Minimum 1, Maximum 10 
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SELECTION DE CELLULES DISJOINTES 
 
Il est possible dans une même sélection d’avoir des cellules disjointes (non conti-
guës), c’est-à-dire non collées les unes aux autres. Pour ce faire il suffit de sélec-
tionner les cellules ou les plages de cellules en maintenant enfoncée la touche 
CTRL. 
 

Sélection de lignes disjointes 
 
Pour sélectionner des lignes disjointes il suffit de cliquer successivement sur les 
en-têtes des lignes à sélectionner en maintenant enfoncée la touche CTRL. 
 

 
 

SELECTION DE LA TOTALITE DE LA FEUILLE DE CALCUL 
 
Il est enfin possible de sélectionner la totalité des cellules de la feuille de calcul en 
cliquant sur le carré vide présent en haut à gauche de la feuille de calcul. 
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Mise en forme d’une feuille de calcul 
 
Dans la plupart des cas, les feuilles de calcul des utilisateurs sont présentées 
sans aucune mise en forme particulière : les options de mise en forme par dé-
faut sont suffisamment pertinentes pour qu’il ne soit pas nécessaire de s’en pré-
occuper.  
Pourtant, recourir aux nombreuses options proposées par les tableurs (polices 
de caractères, couleurs, alignements, présentation des titres) permet de renfor-
cer l’intérêt et la lisibilité des données.  
Comme cela a déjà été signalé, il faut bien distinguer la mise en forme des cel-
lules (choix des polices, couleur, bordures, alignement etc.) de la mise en forme 
des données, qui définit la façon dont sont affichés dates et nombres de la 
feuille de calcul. 
 

MISE EN FORME RAPIDE 
 
La plupart des modifications de mise en forme s’effectuent à l’aide de la barre 
d’outils Mise en forme. Son aspect peut varier selon les tableurs. Nous présentons 
ici celle de Calc. 
 

 
 
Elle propose toutefois généralement des boutons permettant de jouer sur les élé-
ments suivants :  
 
*Police : sélection de la police à appliquer à la plage de cellules sélectionnée.  
*Taille de la police : taille de caractère (en points) pour les cellules sélection-
nées.  
*Gras : bouton bascule appliquant ou supprimant la mise en gras pour la plage 
sélectionnée.  
*Italique : bouton bascule appliquant ou supprimant la mise en italique pour la 
plage sélectionnée.  
*Souligné : bouton bascule appliquant ou supprimant le style souligné pour la 
plage sélectionnée.  
*Aligner à gauche : aligne à gauche le contenu des cellules sélectionnées (valeur 
par défaut pour le texte). 
*Centrer : centre le contenu des cellules sélectionnées. Surtout employé pour les 
titres et les étiquettes de colonne.  
*Aligner à droite : aligne à droite le contenu des cellules sélectionnées (valeur 
par défaut pour les nombres).  
*Fusionner et centrer : centre les données sur une cellule unique s’étendant sur 
plusieurs colonnes. Sert essentiellement pour la présentation des titres.  
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En principe, votre tableur applique automatiquement les effets suivants à vos en-
trées alphanumériques : 
 
• Le texte est automatiquement aligné à gauche. Les nombres considérés comme du 
texte à cause de l’inclusion de caractères non numériques sont également traités de la 
sorte. C’est par exemple le cas d’un numéro de téléphone renfermant des points ou des 
espaces. 
• Le texte ne passe pas à la ligne, sauf action spécifique de votre part. Si vous saisissez 
un texte qui excède la largeur d’une cellule, celui‐ci semblera se déverser dans la cellule 
suivante. S’il y a déjà des données dans la cellule suivante, le texte sera tronqué. Cela 
signifie que l’excédent de texte ne sera pas affiché à moins que vous n’élargissiez la co‐
lonne (nous verrons cela plus tard). Le texte tronqué n’est pas supprimé, mais simple‐
ment masqué. Vous pouvez le vérifier en examinant la barre de formule. 
• Par défaut, le texte est affiché dans une police prédéfinie (souvent Arial 10 points). 
Ce paramètre est modifiable. 
 
Souvent, si vous commencez à taper une entrée qui ressemble à une entrée saisie ailleurs 
dans une autre colonne, le tableur peut compléter automatiquement l’entrée à votre 
place. En outre, si vous orthographiez mal un nom commun, le tableur le corrigera à votre 
place. Excel et Calc contiennent des entrées Correction automatique qu’ils partagent avec 
les autres programmes de leur suite. Elles corrigent les fautes classiques, les problèmes 
de casse, etc. Cette fonction de correction automatique peut toutefois être aussi utile que 
parfois exaspérante. 
 

ASTUCE 
 
De ce qui précède, vous pourriez vous demander comment entrer un nombre (ou 
d’ailleurs certains symboles mathématiques, comme le signe =) sans qu’il ne soit 
reconnu comme nombre.  
C’est facile : débutez simplement votre saisie par un espace, qui sera automati-
quement supprimé dès l’appui sur la touche ENTREE. 
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SAISIE DE DONNEES LITTERALES 
 
Vous êtes prêt à entrer des données dans votre feuille de calcul. Nous vous dé-
conseillons toutefois de le faire avant d’avoir réfléchi soigneusement à ce que 
vous voulez obtenir : de façon générale, mieux vaut bâtir sur une feuille de papier 
un schéma de ce que vous voulez créer. Un peu de réflexion avant de commencer 
se traduit souvent par de précieuses heures économisées par la suite !  
Saisie de données numériques  
 
Lorsque vous saisissez un nombre dans une cellule, le tableur interprète cette 
donnée comme un nombre. Il est alors possible d’employer des formules mathé-
matiques sur cette donnée. Par défaut (c’est-à-dire sans action contraire de votre 
part), les données reconnues comme des nombres sont alignées à droite dans la 
cellule. 
 
Cliquez avec votre souris sur la cellule concernée (si elle n’est pas déjà sélectionnée), puis 
appuyez sur la touche ENTREE. Le nombre saisi apparaît dans la cellule, et le curseur se 
déplace vers la cellule suivante (en dessous ou à droite selon le paramétrage retenu). 

 
 

À SAVOIR 
 
Avec Excel et de nombreux autres tableurs, les nombres saisis sont stockés avec 
une précision de 15 chiffres quel que soit l’affichage dans la cellule. Les chiffres 
au-delà du quinzième sont également stockés, mais sont arrondis dans l’affi-
chage.  
 
Saisie de données alphanumériques  
Lorsque vous saisissez des lettres dans une cellule, le tableur interprète les don-
nées en tant que données alphanumériques : il n’est plus possible d’utiliser des 
outils mathématiques sur ces données. 
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*Bordures : place une bordure autour de la sélection.  
*Couleur d’arrière-plan : définit la couleur de fond de la sélection.  
*Couleur de caractères : définit la couleur du contenu de la sélection.  
Les autres boutons de la barre d’outils Mise en forme concernent la mise en forme 
des nombres. Leur effet va au-delà d’une simple modification de l’apparence du 
contenu sélectionné. 
 

MISE EN FORME ELABOREE 
 
Vous pouvez disposer de beaucoup plus d’options en sélectionnant une plage, 
puis en choisissant dans le menu Format > Cellules ou en cliquant avec le bouton 
droit de la souris et en choisissant dans le menu contextuel Format > Cellule 
(Excel) ou Formater les cellules (Calc). 
 

 
 

La boîte de dialogue Formatage des cellules qui apparaît permet de définir aussi 
bien le format des données (comme nous l’avons vu précédemment) que celui des 
cellules, grâce à différents onglets (variables selon le produit). Certains de ceux-ci 

sont particulièrement intéressants :  
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*Alignement : outre l’alignement horizontal (Gauche, Droite, Centré), qui peut du 
reste s’ajuster directement depuis la barre d’outils, cet onglet permet de régler 
l’alignement vertical (Haut, Centré, Bas, Justifié) et l’orientation du texte. L’option 
Renvoi à la ligne automatique conduit à un ajustement automatique du texte et de 
la taille des cellules sélectionnées : le texte est visible intégralement et occupe le 
volume de la cellule. 
 

 
 
*Effets de caractères : permet (entre autres) d’ajouter un effet de relief, un con-
tour et ou un ombrage aux caractères du contenu de la cellule. 
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Ainsi lorsqu'une cellule ou une plage de cellule possède un nom (le terme d'étiquette est 
parfois utilisé), il est possible d'y faire référence via le nom. Cette fonctionnalité est parti‐
culièrement utile lorsque certaines cellules ou plages de cellules contiennent des données 
caractéristiques, car il est possible d'y faire référence via le nom même si la cellule ou le 
groupe de cellules a été déplacé. 
 
Dans une facture par exemple il est judicieux de donner un nom comme total_ht à la cel‐
lule donnant le total hors taxe des commandes. Vous pouvez également créer une cellule 
nommée TVA contenant l'indice de la TVA, ainsi lorsque vous déciderez de calculer le 
montant TTC, il suffira de faire le produit de la cellule nommé total_ht par la cellule nom‐
mée TVA. 
 

Commentaire 
 
Il est possible d'ajouter un commentaire (parfois appelé annotation) à une cellule afin de 
fournir des informations additionnelles que l'on ne souhaite pas (ou que l'on ne peut pas) 
voir figurer dans la feuille de calcul. 
 
Pour ajouter un commentaire à une cellule sous Excel il suffit de sélectionner la cellule ou 
la plage de cellules à nommer puis d'aller dans Insertion > Commentaire ou bien de cli‐
quer dessus avec le bouton droit et de choisir insérer un commentaire. 
 

 
 

 

Notez la présence d'un petit triangle rouge en haut à droite de la cel‐
lule D5 indiquant que la cellule possède un commentaire, invitant l'utilisa‐
teur à survoler la cellule avec sa souris pour en voir le contenu. 
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• Lorsque le décalage est nul il n'est pas nécessaire de noter un zéro entre parenthèse. 
Ainsi L(0)C(12)peut être noté LC(12). 
• En mode A1 l'expression du décalage entre les cellules est masqué. En effet une réfé‐
rence relative en mode A1 est implicite : il suffit d'indiquer les coordonnées de la cellule 
pointée (référencée) sans indiquer de signe $ : 
 

 
 

Référence mixte 
 
On appelle référence mixte, une référence dans laquelle la position horizontale de la cel‐
lule est exprimée de manière absolue et la position verticale de façon relative, ou inverse‐
ment. 
• En notation L1C1 une référence mixte sera de la forme L2C(3) ou L(4)C17. 
En notation A1 une référence mixte sera de la forme $C5 ou F$18. 
 

Référence nommée 
 
Il est possible de donner un nom à une cellule ou un groupe de cellule. 

 

Pour nommer une cellule sous Excel il suffit de sélectionner la cellule ou la 
plage de cellules à nommer puis d'aller dans Insertion > Nom > Définir 

 ϣϧ 

 

*Bordures : permet de définir le type et la couleur des bordures à appliquer à la 
sélection. Les bordures permettent d’attirer l’attention sur certains nombres, ou de 
bien séparer différentes sections d’une même feuille de calcul. 
 

 
 

À SAVOIR 
 
Vous pouvez facilement supprimer une bordure en sélectionnant la plage concer-
née, en déroulant la liste du bouton Bordure, et en sélectionnant Aucune bordure 
dans la palette affichée.  
 
*Arrière-plan (Calc)/Remplissage (Excel) : permet de définir la couleur d’arrière-
plan de la sélection. Excel permet en outre de sélectionner un motif de remplis-
sage. Pour supprimer à la fois une couleur de remplissage et un motif, sélection-
nez la ou les cellules concernées, cliquez sur la zone de liste Couleur de remplis-
sage, et choisissez Aucun remplissage. Pour supprimer l’un ou l’autre seulement 
(Excel uniquement), ouvrez la boîte de dialogue Format de cellule, activez l’onglet 
Motifs, puis cliquez sur Aucune couleur dans la zone Couleur ou sur Solide dans 
la liste Motif. 
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Choisissez avec prudence votre couleur ou votre motif de remplissage car cela peut péna‐
liser la lisibilité du contenu des cellules. Si vous modifiez ensuite la couleur du texte en 
clair, celui‐ci pourrait devenir illisible après impression sur une imprimante noir et blanc, 
qui rend les couleurs en tons de gris. 
 
Couleurs d’arrière-plan et motifs peuvent être précieux lors de la conception de 
feuilles de calcul qui doivent être renseignées par l’utilisateur. Ils peuvent lui indi-
quer les cases à ne pas remplir. 
 
MISE EN FORME DE CARACTERES INDIVIDUELS 
 
Généralement, une mise en forme porte sur des cellules entières. Il est toutefois 
possible de mettre en forme séparément des caractères, mots, nombres, phrases, 
etc., au sein d’une cellule. Il suffit pour cela de sélectionner les caractères, et d’ap-
pliquer le format souhaité.  
Si vous augmentez la taille de caractères individuels, le tableur ajuste générale-
ment automatiquement la hauteur de la ligne en conséquence, comme si vous 
aviez appliqué cette modification à toute la cellule. 
 

 
 

STYLES 
 
Les styles sont des ensembles de formats spécialement conçus pour appliquer 
simultanément des mises en forme prédéfinies à une cellule ou à une plage de 
cellules. Le style Normal (celui appliqué par défaut à tout nouveau contenu) con-
siste en ajustements de polices, en alignements, en bordures, en motifs, etc. Pour 
utiliser les styles, sélectionnez Format > Style (Excel) ou Format > Styles et forma-
tage (Calc) pour afficher à l’écran la boîte de dialogue de même nom. La suite 
diffère selon le produit employé. 
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Références à une cellule 
 
Afin de pouvoir manipuler des données provenant de différentes cellules dans des calculs, 
il est nécessaire de pouvoir y faire référence. Il existe plusieurs façons de faire référence à 
une cellule : 
 

Référence absolue 
 
La référence absolue représente le moyen de désigner une cellule de façon unique dans 
une feuille de calcul. Selon le mode de référence (L1C1 ou A1) la référence absolue sera 
notée différemment : 
 
• En mode L1C1: la référence absolue à une cellule se fait en précédant le numéro de 
ligne par la lettreL et le numéro de la colonne par la lettre C. 
 
LNumeroLigneCNumeroColonne 
 
• Par exemple L12C24 pour la cellule située à l'intersection de la ligne 12 et de la co‐
lonne 24. 
 
• En mode A1: la référence absolue à une cellule se fait en précédant le numéro de 
ligne et le numéro de la colonne par le signe $. 
 
$LettreColonne$NumeroLigne 
 
Par exemple $AC$34 pour la cellule située à l'intersection de la colonne notée AC et de la 
ligne 34. 
 

Référence relative 
 
La référence relative d'une cellule est l'expression de sa position par rapport à une autre 
cellule. Ainsi, une référence relative donne le décalage (en terme de nombre de lignes et 
de colonnes) entre la cellule (dîtede référence) et une cellule pointée (dîte cellule référen‐
cée). Par convention on note négativement un décalage vers le haut pour l'axe vertical et 
un décalage vers la gauche pour l'axe horizontal. 
 
• En mode L1C1: la référence relative à une cellule se fait en indiquant les coordonnées 
de la cellule entre parenthèses : 
 
L(NuméroDeLigne)C(NuméroDeColonne) 
 
• Par exemple L(3)C(‐2) pour la cellule situé 3 lignes plus bas et 2 colonnes à gauche 
par rapport à la cellule de référence : 
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La notion de cellule 
 
On appelle "cellule" l'intersection entre une ligne (horizontale) et une colonne (verticale) 
de la feuille de calcul. Ainsi le nom de la ligne combiné au nom de la colonne donne les 
coordonnées d'une cellule (le terme d'adresse est parfois également utilisé). 
On distingue généralement deux types de coordonnées (appelés styles de référence) se‐
lon les tableurs : 
• Le mode dit L1C1 (Ligne 1, Colonne 1) où la cellule est repérée par le numéro de ligne 
précédé de la lettre L et le numéro de la colonne précédé de la lettre C. L12C34 désignera 
ainsi la cellule à l'intersection de la 12ème ligne et la 34ème colonne. 
 

 
 
• Le mode dit A1 où les numéros de ligne sont repérés par des chiffres et les colonnes 
par des lettres. Ainsi AA17 désigne la cellule à l'intersection de la 27ème colonne et la 
17ème ligne. 
 

 
 

 

La plupart des tableurs proposent de passer d'un mode à l'autre dans leurs 
options. Sous Excel et StarOffice, il suffit d'aller dans Outils > Options > Géné‐
ral et de cocher la case "Style de référence L1C1". 
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Avec Excel 

 
 
Normal est le seul style par défaut à appliquer autant d’éléments de mise en 
forme. Les autres styles par défaut ne spécifient que le format des nombres, ainsi 
que l’alignement et le placement des caractères additionnels tels que les signes 
dollar, les virgules décimales et les virgules, comme le montre la liste qui suit :  
 
*Milliers et Milliers [0] : ces deux styles introduisent des espaces dans les nombres 
supérieurs à 999,99, de sorte à marquer les milliers. Le style Milliers affiche deux 
chiffres décimaux, le style Milliers [0] n’en affiche aucun.  
 
*Monétaire et Monétaire [0] : ces deux styles introduisent le séparateur décimal et 
le symbole monétaire qui correspondent aux paramètres régionaux définis pour 
votre ordinateur. Pour les utilisateurs du français standard, le style Monétaire af-
fiche les nombres avec deux décimales, des espaces entre les milliers, et les fait 
suivre du symbole Υ. Le style Monétaire [0] n’affiche quant à lui aucune décimale.  
 
*Pourcentage [%] : ce style affiche les nombres suivis du symbole de pourcentage 
[%]. Les quantités en pourcentage doivent être saisies sous leur forme décimale. 
Par exemple, la saisie du nombre 0,15 donne à l’affichage 15 %.  
Pour appliquer rapidement aux cellules sélectionnées les styles Milliers, Monétaire 
et Pourcentage, servez-vous des boutons correspondants de la barre d’outils Mise 
en forme. 
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Avec Calc 
 

 
 
Le style Standard correspond au style Normal d’Excel. Les autres styles proposés 
(Titre, Titre1, Résultat et Résultats2) jouent sur différents paramètres (gras, taille, 
etc.). Les styles Monétaire et Pourcentage existent également, mais ne sont pas 
accessibles depuis cette boîte de dialogue : servez-vous des boutons correspon-
dants de la barre d’outils Mise en forme.  
Avec les deux produits, la barre d’outils propose des boutons permettant de modi-
fier le nombre de décimales affichées. 
 
ASTUCE 
 
La modification du nombre de décimales, pour les cellules mises en forme avec 
les styles Milliers ou Monétaire n’implique pas l’application des styles Milliers [0] et 
Monétaire [0]. Pour appliquer ces derniers à des cellules sélectionnées, vous de-
vez passer par la boîte de dialogue Style. 
 
Style personnalisé 
 
Exactement comme pour les styles de traitement de texte que vous connaissez 
peut-être déjà, les tableurs permettent généralement de définir des styles person-
nalisés susceptibles de conférer une certaine homogénéité aux tableaux créés par 
une personne ou une entreprise.  
Vous pouvez créer un style personnalisé de deux façons :  
*Définir intégralement un nouveau style via les boîtes de dialogue Style et Format 
de cellule.  
*Partir d’une cellule déjà mise en forme, qui va servir de modèle lors de l’élabora-
tion du nouveau style.  
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La notion de feuille de calcul 
 
Un tableur présente les données et les formules sous forme d'un tableau (lignes et co‐
lonnes) appelé feuille de calcul. 
 
Une feuille de calcul est constitué de lignes (numérotées à l'aide de chiffres) et de co‐
lonnes (numérotées à l'aide de lettres). Le croisement d'une ligne et d'une colonne est 
appelé cellule. Une cellule est donc repérée par un nombre et une lettre. 
 
Une feuille de calcul peut ainsi contenir jusqu'à 65536 lignes et 256 colonnes, soit plus de 
17 millions de cellules. 
 
Chacune des cellules de la feuille de calcul peut contenir des valeurs. Ces valeurs sont soit 
saisies directement (nombres, texte, date, ...) ou bien calculées automatiquement; par le 
tableur on parle alors deformules, c'est‐à‐dire des expressions permettant de calculer 
une valeur, éventuellement en fonction des valeurs d'une ou plusieurs autres cellules de 
la feuille de calcul. 
 
Le tableur possède ainsi un grand nombre de fonctions intégrées permettant d'effectuer 
des calculs mathématiques, statistiques, … 
 
Voici un exemple de feuille de calcul contenant des notes d'élèves et dont les moyennes 
sont calculées automatiquement par le tableur : 
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La syntaxe des fonctions qui ne respectent pas ce modèle est précisée le cas 
échéant.  
 

BDMOYENNE 
Indique la moyenne des valeurs correspondant à des critères 
donnés 

BDNB 
Compte le nombre de cellules qui contiennent des nombres 
correspondants à des critères donnés 

BDNBVAL 
Compte les cellules non vierges qui contiennent des nombres 
(ou du texte) correspondant aux critères spécifiés 

BDLIRE 
Renvoie une valeur unique correspondant aux critères spécifiés. 
Si des doublons sont trouvés, BDLIRE renvoie #NOMBRE (Excel) 
ou Err502 (Calc) 

BDMAX Extrait la valeur maximale correspondant aux critères spécifiés 

BDMIN Extrait la valeur minimale correspondant aux critères spécifiés 

BDPRODUIT 
Renvoie le produit de la multiplication des valeurs correspon‐
dant aux critères spécifiés 

BDECARTYPE 
Renvoie le calcul de l’écart‐type d’une population par rapport à 
la population globale 

BDSOMME Renvoie le total des valeurs correspondant aux critères spécifiés 

BDVAR  
Estime la variance d’une population sur un échantillon de popu‐
lation en fonction des valeurs qui correspondent aux critères 
spécifiés 

BDVARP 
Renvoie le calcul de la variation d’une population entière en 
fonction des valeurs qui correspondent aux critères spécifiés 

BDECARTYPE 
Calcule, à partir d’un échantillon, l’écart‐type d’une population 
donnée 

BDECARTYPEP  
Calcule l’écart‐type d’une population donnée à partir de toutes 
les cellules comprises dans une plage de données correspon‐
dant aux critères de recherche 

LIREDONNEES‐
TABCROISDYNAMIQUE 

Excel uniquement. Renvoie une valeur de données dans un ta‐
bleau croisé dynamique. La syntaxe est la sui‐
vante :=LIREDONNEESTABCROISDYNAMIQUE 
(tableau_croisé_dyn;nom) 
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Voici comment procéder :  
 
*Sélectionnez une cellule dont vous voulez utiliser la mise en forme pour élaborer 
votre style. Si ce n’est pas le cas, sautez cette étape, ou sélectionnez celles des 
cellules auxquelles vous souhaitez appliquer le nouveau style à créer.  
La suite des opérations dépend légèrement du tableur concerné. 
 
Avec Excel 
 
*Choisissez Format > Style pour ouvrir la boîte de dialogue Style.  
*Saisissez le nom de votre nouveau style dans la zone de nom de style.  
*Sélectionnez, à votre convenance, les options de la section Le style inclut de la 
boîte de dialogue.  
*Cliquez sur le bouton Définir pour afficher à l’écran la boîte de dialogue Format 
de cellule. Apportez les modifications souhaitées. Cliquez ensuite sur OK pour 
retourner à la boîte de dialogue Style.  
*Pour appliquer immédiatement ce nouveau style aux cellules sélectionnées, cli-
quez sur OK. Pour ajouter ce style à la liste des styles sans l’appliquer au classeur 
courant, cliquez sur Ajouter. Vous pouvez ensuite fermer la boîte de dialogue en 
cliquant sur Fermer, ou bien continuer à élaborer de nouveaux styles avant de 
cliquer sur Fermer. 
 

Avec Calc 
 
*Choisissez Format > Styles et formatage pour ouvrir la boîte de dialogue Styles et 
formatage.  
*Cliquez sur le bouton Nouveau style à partir de la sélection. Si vous créez un 
style sans avoir effectué de sélection, effectuez un clic droit sur un des styles exis-
tants et choisissez Nouveau.  
*Saisissez le nom de votre nouveau style dans la zone Nom du style, puis cliquez 
sur OK.  
*Cliquez droit sur le nouveau style et choisissez Modifier. Cela fait apparaître la 
boîte de dialogue Style de cellule.  
*Effectuez dans cette boîte de dialogue les modifications souhaitées. Cliquez en-
suite sur OK pour retourner à la boîte de dialogue Styles et formatage.  
*Pour appliquer immédiatement ce nouveau style aux cellules sélectionnées, cli-
quez sur OK.  
Pour appliquer un style, sélectionnez les cellules concernées, choisissez Format > 
Style (ou Format > Styles et  
formatage), sélectionnez le style dans la liste, puis cliquez sur OK. 
 
Modifier un style existant 
Vous pouvez modifier tout style existant, qu’il s’agisse d’un style prédéfini ou d’un 
style personnalisé 
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Avec Excel 
 
*Choisissez Format > Style pour ouvrir la boîte de dialogue Style.  
*Sélectionnez le nom du style concerné dans la zone de nom de style.  
*Sélectionnez les options adéquates de la section Le style inclut de la boîte de 
dialogue.  
*Cliquez sur le bouton Modifier pour afficher à l’écran la boîte de dialogue Format 
de cellule. Apportez les modifications souhaitées, puis cliquez sur OK pour revenir 
à la boîte de dialogue Style. 
 
Avec Calc 
 
*Choisissez Format > Styles et formatage pour ouvrir la boîte de dialogue Styles et 
formatage.  
*Cliquez droit sur le style concerné et choisissez Modifier. Cela fait apparaître la 
boîte de dialogue Style de cellule.  
*Effectuez dans cette boîte de dialogue les modifications souhaitées. Cliquez en-
suite sur OK pour retourner à la boîte de dialogue Styles et formatage. 
 
MISE EN FORME CONDITIONNELLE 
 
La mise en forme conditionnelle est une puissante fonction désormais proposée 
par de nombreux tableurs, dont Excel et Calc. Comme son nom l’indique, elle con-
siste à appliquer une mise en forme particulière à une sélection en fonction d’une 
ou plusieurs conditions. 
 
Si Calc vous impose de sélectionner un style prédéfini (intégré ou personnalisé), 
vous devez avec Excel définir la totalité de la mise en forme : les deux méthodes 
présentent avantages et inconvénients.  
 
*Dans les deux cas, sélectionnez la plage concernée puis choisissez dans le me-
nu Format > Mise en forme conditionnelle. 

 
 

 Ϥϫ 

 

Voici le résultat interprété par le tableur : 
 

 
 
 
 
 

Fonctions de tableur 
 
Vous trouverez ci-dessous une liste non exhaustive des principales fonctions pro-
posées par Excel et Calc. Il sera précisé lorsqu’une fonction n’est disponible 
qu’avec l’un des deux tableurs, ainsi que lorsque la syntaxe diffère. 
 
Fonctions de gestion de bases de données et de listes 
 
Presque toutes les fonctions de base de données ou de liste du tableau suivant se 
conforment à la syntaxe générale suivante :  
 
=Fonction(plage;champ;critère) 
 
• L’argument plage se réfère à la plage qui contient la liste ou la base de données. 
• L’argument champ se réfère à une colonne donnée dans la liste. En l’absence de cet 
argument, la fonction opère sur toute la liste. Vous pouvez vous référer à un nombre de 
colonne, au nom d’un en‐tête de colonne (entre guillemets), ou à une référence de cellule 
qui se réfère à une étiquette ou à un nombre de colonne. 
• L’argument critère spécifie les bases sur lesquelles vous voulez que la fonction sélec‐
tionne des cellules données. Les critères comprennent une copie de la liste des en‐têtes 
de colonne de la liste avec des mots, des phrases, des valeurs numériques ou des for‐
mules stockés sous ces en‐têtes. 
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Gardez toutefois bien présent à l’esprit qu’il ne s’agit que d’exemples et que votre 
tableur possède plus que probablement de très nombreuses autres fonctions : 
reportez-vous à sa documentation. Vous trouverez en annexe une liste plus com-
plète (mais non exhaustive) des fonctions proposées par Excel et Calc.  
À nouveau, mettons en pratique ce que nous venons d’apprendre, en reprenant 
l’exercice précédent. 
 
EXEMPLE PRATIQUE 
 
Pour calculer automatiquement le total HT et TTC des commandes, il est possible 
d’utiliser la fonction Somme(). Pour ce faire, il suffit de sélectionner la cellule dans 
laquelle on souhaite voir figurer la somme, de saisir une formule (en la commen-
çant par le signe =) en utilisant la fonction Somme(). Il existe plusieurs façons de 
saisir cette fonction : 
 
• en la saisissant manuellement dans la barre de formule ; 
en utilisant le bouton Fonction permettant de choisir la fonction dans une liste : 
 
 
 
 
 
 
 
 
en utilisant directement le bouton Somme. 
 
 
Quelle que soit la façon choisie, il est essentiel de préciser les arguments de la 
fonction Somme(), c’est-à-dire de lui préciser les cellules dont la somme doit être 
faite. Deux possibilités s’offrent à nouveau à l’utilisateur : 
 
• saisir au clavier les références des cellules à sélectionner, 
sélectionner les cellules ou les blocs de cellules à sélectionner. 
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*Définissez la ou les conditions, choisissez le style à appliquer (Calc) ou définis-
sez une mise en forme (Excel), puis cliquez sur OK.  
Les mises en forme conditionnelles peuvent être exploitées dans de nombreuses 
circonstances, dont voici quelques exemples. 
 

Éviter les doublons 
 
Il est possible grâce aux mises en forme conditionnelles de repérer rapidement 
des doublons lors de la saisie dans une colonne :  
 
*Appliquez une mise en forme conditionnelle à la première cellule sous les titres 
(par exemple, A2).  
*Saisissez comme condition la formule suivante (nous examinerons plus en détail 
les formules dans le chapitre suivant) :  
=NB.SI($A$2:$A$21;A2)>1  
*Sélectionnez la couleur de fond désirée en cas de doublon, puis cliquez sur OK.  
*Recopiez ce format à l’aide de l’outil Reproduire la mise en forme (le petit pin-
ceau) sur les lignes suivantes.  
Tout doublon sera alors repéré rapidement par le format défini (ici, un texte gras 
en rouge). 

 
 
MISE EN FORME AUTOMATIQUE 
 
Les tableurs proposent également souvent une commande qui permet d’accéder à 
toute une gamme d’effets prédéfinis, qui peuvent être appliqués à toute plage de 
cellules d’une feuille de calcul. Cette commande du menu Format se nomme Mise 
en forme automatique avec Excel et Autoformat avec Calc.  
Elle s’emploie de la façon suivante :  
 
*Sélectionnez la plage concernée (elle doit comporter au moins deux cellules et ne 
peut comprendre que des cellules contiguës).  
*Choisissez Format > Mise en forme automatique (Excel) ou Format > Autoformat 
(Calc). 
  
*Sélectionnez une des mises en forme proposées dans la liste affichée à l’écran. 
Un aperçu s’affiche dans la zone de droite. 
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*Un clic sur le bouton Options affiche la liste des options de mise en forme qui 
correspondent à la mise en forme sélectionnée. Vous pouvez désélectionner ces 
formats, à votre convenance, pour qu’ils ne soient pas appliqués lors de la mise 
en forme automatique.  
*Cliquez sur OK.  
 
Les dimensions et le contenu de la plage de cellules sélectionnées peuvent ne 
pas être parfaitement adaptés à la mise en forme automatique retenue. Supprimez 
alors l’effet de mise en forme qui pose problème ou exécutez la commande Annu-
ler pour supprimer la mise en forme automatique. Vous pouvez ensuite à nouveau 
appliquer la mise en forme automatique, mais en désactivant le format gênant. 
 

ASTUCE : COPIER UNE MISE EN FORME 
 
L’outil Reproduire la mise en forme (Excel) ou Appliquer le format (Calc) de la 
barre d’outils permet d’appliquer rapidement une mise en forme déjà définie avec 
soin à une autre sélection de la feuille de calcul. 
 

 
 

MISE EN FORME ET LISIBILITE DE LA FEUILLE DE CALCUL 
 
Quelles que soient les méthodes utilisées pour appliquer des polices, des tailles 
de police et des formats, les modifications apportées à la mise en forme doivent 
contribuer à améliorer l’aspect général des feuilles de calcul. Une telle améliora-
tion implique une plus grande lisibilité. Pour ce faire, voici quelques recommanda-
tions :  
 
*Polices de caractères. Attention à ne pas employer des polices exotiques, qui 
pourraient ne pas être installées sur l’ordinateur d’un autre utilisateur. Une feuille 
de calcul ne devrait comporter qu’un maximum de quatre polices différentes, sa-
chant que les différences de taille sont considérées comme nouvelles polices.  
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Une fois une cellule ou une plage de cellules dotée d’un nom, il est possible d’y 
faire référence via ce nom. Cette fonctionnalité est particulièrement utile lorsque 
certaines cellules ou plages de cellules contiennent des données caractéristiques, 
car il est possible d’y faire référence via le nom même après un éventuel déplace-
ment de la cellule ou de la plage de cellules.  
Dans une facture, par exemple, il est judicieux de donner un nom comme total_ht 
à la cellule donnant le total hors taxe des commandes. Vous pouvez également 
créer une cellule nommée TVA contenant l’indice de la TVA, ainsi lorsque vous 
déciderez de calculer le montant TTC, il suffira de faire le produit de la cellule 
nommé total_ht par la cellule nommée TVA. La cellule nommée TTC contiendrait 
ainsi la formule suivante :  
= total_ht * TVA  
 

Fonctions 
 
Il est également possible d’utiliser des fonctions dans les formules, permettant de 
faire des calculs avancés.  
 
Une fonction est caractérisée par son nom (écrit par convention en majuscules), 
suivi de parenthèses. Elle peut éventuellement contenir des arguments (à l’inté-
rieur des parenthèses), c’est-à-dire un ensemble de valeurs, séparées par des 
points-virgules, auxquelles la fonction s’applique. Ainsi une fonction appelée 
FONCTION se notera de la façon suivante :  
 
FONCTION(argument1; argument2; ...)  
 
Les tableurs fournissent généralement un grand nombre de fonctions intégrées 
permettant de réaliser des manipulations de données (Excel et Calc en proposent 
plus de 400). Voici les principales catégories proposées : 
 
• Mathématique et trigonométrie : fonctions mathématiques et trigonométriques 
offrant des outils de base de manipulation de données numériques. 
• Date & Heure : servent à insérer, manipuler et convertir des dates et des heures. 
• Texte : fonction de manipulation de chaînes de texte. 
• Information : fonctions d’informations sur le contenu de cellules. 
• Logique : fonctions logiques permettant de manipuler des données logiques (ET, 
OU…). 
• Statistique : fonctions statistiques offrant des outils d’analyse, de moyenne. 
• Finances : fonctions financières mathématiques permettant de manipuler des don‐
nées monétaires. 
• Scientifique : fonctions scientifiques évoluées nécessitant généralement l’installation 
d’un module complémentaire. 
• Base de données : fonctions employées avec des données organisées sur une seule 
ligne de données pour chaque enregistrement. 
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Lorsque le décalage est nul il n’est pas nécessaire de noter un zéro entre paren-
thèses. Ainsi L(0)C(12) peut être noté LC(12). 
 
• En mode A1, l’expression du décalage entre les cellules est masquée. En effet le 
mode A1 emploie implicitement des références relatives. Il suffit d’indiquer les coordon‐
nées de la cellule pointée (référencée) sans indiquer de signe $ : 
 

 
 
REFERENCE MIXTE 
 
On appelle référence mixte, une référence dans laquelle la position horizontale de 
la cellule est exprimée de manière absolue et la position verticale de façon rela-
tive, ou inversement. 
 
• En notation L1C1 une référence mixte sera de la forme L2C(3) ou L(4)C17. 
En notation A1 une référence mixte sera de la forme $C5 ou F$18. 
 

REFERENCE NOMMEE 
 
Il est possible de donner un nom à une cellule ou un groupe de cellules. Cela 
porte également le nom de plage nommée ou d’étiquette.  
Pour nommer une cellule, sélectionnez la cellule ou la plage de cellules à nommer 
puis allez dans Insertion > Nom > Définir (sous Excel) ou Insertion > Noms > Défi-
nir (sous Calc).  
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*Taille des polices. Si des caractères trop petits gênent la lecture des feuilles de 
calcul, cela permet d’augmenter le volume des informations contenues sur une 
même feuille. Il faut donc trouver le meilleur compromis possible. L’expérience 
montre que les meilleurs choix consistent à adopter des tailles de caractères de 8 
ou 10 points pour les données, avec des étiquettes de colonnes et de lignes en 12 
ou 14 points. Peu importe pour les titres des feuilles de calcul.  
 
*Alignement et orientation. Veillez à posséder un alignement homogène entre 
données de même type. Servez-vous si besoin est du bouton Centrer et fusionner 
pour mettre en valeur un titre ou une étiquette multi-colonnes. Le choix d’une 
orientation verticale est parfois intéressant pour des étiquettes de colonne ou des 
étiquettes multi-lignes (en employant alors également Centrer et fusionner)  
 

Saisie d’une formule 
 
Le principal intérêt d’un tableur est de permettre l’automatisation des calculs : em-
ployer des cellules pour effectuer des opérations en fonction des valeurs d’autres 
cellules. Le tableur recalcule ainsi toutes les valeurs à chaque changement d’une 
valeur d’une cellule.  
 
On parle ainsi de formule pour désigner l’expression qui, une fois saisie dans une 
cellule, permet au tableur d’effectuer automatiquement un calcul à partir des va-
leurs d’autres cellules et d’afficher un résultat. 
Les formules peuvent ainsi contenir des références à d’autres cellules, des ex-
pressions, ou bien des fonctions. 
 
La saisie d’une formule se fait en sélectionnant une cellule puis en commençant 
sa saisie par le signe d’égalité (=). Celui-ci apparaît dans la barre de formules. 
 

 
 
Vous saisissez ensuite les références des cellules à utiliser et, éventuellement, 
des opérateurs et/ou fonctions.  
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Il est également possible de cliquer sur le bouton Formule de la barre de formules. 
Ainsi l’exemple suivant schématise l’utilisation d’une formule dans la cellule C15 
pour effectuer la somme des cellules D11 et D13. 
 

 
 
Lors de l’appui sur le bouton ENTREE, le tableur calcule la valeur de la cellule 
C15 et en affiche le résultat : 
 

 
 
Une formule ou expression se décompose en plusieurs éléments bien distincts : 
• zéro, une ou plusieurs références à une ou plusieurs cellules ; 
• zéro, un ou plusieurs opérateurs ; 
• zéro, une ou plusieurs fonctions. 
 
Nous allons examiner successivement ces différents éléments. 
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Référencement d’une cellule 
 

Afin de pouvoir manipuler des données provenant de différentes cellules dans des 
calculs, il est nécessaire de pouvoir y faire référence. Il existe plusieurs façons d’y 
parvenir : 
• référence absolue, 
• référence relative, 
• référence mixte, 
référence nommée 
 

REFERENCE ABSOLUE 
 
La référence absolue représente le moyen de désigner une cellule de façon 
unique dans une feuille de calcul. Selon le mode de référence (L1C1 ou A1), la 
référence absolue sera notée différemment : 
 
• En mode L1C1, la référence absolue à une cellule se fait en faisant précéder le numé‐
ro de ligne par la lettre L et le numéro de la colonne par la lettre 
C :LNumeroLigneCNumeroColonne 
 
Par exemple, L12C24 pour la cellule située à l’intersection de la ligne 12 et de la 
colonne 24. 
 
• En mode A1 (le mode par défaut), la référence absolue à une cellule se fait en faisant 
précéder le numéro de ligne et le numéro de la colonne du signe 
$ :$LettreColonne$NumeroLigne 
 
Par exemple, $AC$34 pour la cellule située à l’intersection de la colonne notée AC 
et de la ligne 34. 
 
REFERENCE RELATIVE 
 
La référence relative d’une cellule est l’expression de sa position par rapport à une 
autre cellule. Ainsi, une référence relative donne le décalage (en terme de nombre 
de lignes et de colonnes) entre la cellule (dite de référence) et une cellule pointée 
(dite cellule référencée). Par convention on note négativement un décalage vers le 
haut pour l’axe vertical et un décalage vers la gauche pour l’axe horizontal. 
 
• En mode L1C1, la référence relative à une cellule se fait en indiquant les coordonnées 
de la cellule entre parenthèses :L(NuméroDeLigne)C(NuméroDeColonne) 
 
Par exemple L(3)C(-2) pour la cellule située 3 lignes plus bas et 2 colonnes à 
gauche par rapport à la cellule de référence : 


